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User Manual DALIeco PC-Software 
(For DALIeco PC Software Ver. 1.0.4.xxx) 
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0. Introduction 
 
The DALIeco PC software allows a comfortable creation and visualisation of individual configurations 
for the DALIeco control unit. Configurations can be uploaded to the memory of the DALIeco master 
remote via USB and subsequently transmitted on a single button press to the control unit by IR 
telegrams.  
In addition to that, buttons of the master remote can be disabled or enabled and the IR code of the 
control system can be changed. 

1.  Graphic user interface (GUI) layout 
 

Menu bar Tool bar Vizualsiation / preview area
Language 

setting

Base mode 

selection

Base functions tab
Advanced functions 1 tab

Remote control functions tab

Progress barAdvanced functions 2 tab
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2. Menu bar 
 

2.1. File Menu 

 
 
The File menu bar offers following options 

 
 Create a New project (all settings of the GUI will be reset to default) 

 Open an existing project:  
A standard file selection window will be displayed and a previously stored DALIeco project file 
(*.osrde) can be selected 

 Save current changes to the current project file 

 Save current settings as a new project file 

 Select and open one of the recently opened files  

 Close and Exit the DALIeco PC Software 

2.2. Edit Menu 

 
 
The Edit menu bar offers following options 

 
 Undo last action 

 Redo last action  

 RESET current configuration settings to default 
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2.3. Transfer Menu 

 
 
The Transfer menu bar offers following options 
 

 Upload the current DALIeco Configuration to the memory of the master remote 

 Upload the current enabled / disabled Key settings to the Master Remote Control  

 Reset the  enabled / disabled Key settings to the Master Remote Control (= all keys enabled) 

 Download the enabled / disabled Key settings from the Master Remote Control to the PC 
 
Remark:  
The Transfer Menu is only fully accessible if a Master Remote is connected to a USB port of the PC 
via the red OSRAM Original equipment USB cable. 

2.4. Help menu 

 
 
The Help menu bar offers following options 

 Show help file via PDF reader 

 Display information About the OSRAM DALIeco PC-Software 

 

2.5. Change language  

 
 
The language of the GUI can be changed by clicking onto the flag icon on the right side of the menu 
bar. 
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3. Tool bar 

Create a 

new project

Open a new

project

Safe current 

project to a 

new location

Undo last 

action

Redo last 

action

RESET all 

settings to default

Upload 

configuration to 

the master remote

Upload key lock 

setting  to the 

master remote

Enable all keys of 

the master remote

Download the key lock 

setting to the PC

 
 

4. Visualization area 
 
 

States

Light is off

Light is on

Event Timer setting 
Time axis

Dimming 

level axis

Dimming level 

DALI channel 1 

Dimming level 

DALI channel 2  
 
The visualization area provides a preview of the “light over time behaviour” of the two DALI channels. 
While the Y-axis shows the dimming level, the X-axis reflects the progressing time. 
Triggered by events (e.g. detected motion or an expired timer), the control unit changes between 
different states.  Types and number of the depicted states depend on the selected base mode and the 
individual configuration.  
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5. Individual functions setting 

5.1. Base functions 
 

 
 
The base functions represent the most important and most common parameter settings.  

 

5.1.1. DALI channel 
 

 Auto setup level 
The auto setup level is the percentage of the artificial light that the controller will choose as set 
point for the daylight dependent close loop control, when the Auto setup button of the master 
remote is pressed during programming mode or the sensor integrated button is pressed for more 
than 10s. 
Remark: This parameter is only available if the Light regulation is activated (= set to Automatic or 
Semi automatic). 

 

 On level 
The On level is the dimming level of channel 1 respectively of channel 2 that the controller will 
establish when it changes to the ON-state. 
Remark: This parameter is only available if the Light regulation is set to OFF  

 
 Switch off delay 

The switch off delay is the time after that the controller will leave the ON-state.  
The switch off delay time is retriggered by each motion signal or manual user operation. 
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 Stand-by 1 level 
This level will be established after leaving the ON-state. If the light regulation is  
activated the percentage value is not an absolute dimming level but a relative value to the set point. 
If the Stand-by 1 level for both channels is set to OFF, the controller will skip the Stand-by 1 state 
and directly change to the OFF-state. 

 
Example for a relative stand-by level: If the stand-by level is set to 50%, the controller will reduce 
the regulation down to 50% of the regulation level choosen for the ON-state. 
 
Remark: 
- If light regulation is enabled channel 1 and 2 are linked by the choosen offset. 
- If light regulation is set to OFF, the stand-by levels are absolute values and can be set   
 differently for channel 1 and 2. 

 

 Stand-by 1 time 
This is the time after that the controller will leave the Stand-by 1 state and either change to Stand-
by-2 or OFF-state. 

 
 Offset 

The Offset is the percentage difference in light output between channel-1 and channel-2. Example: 
If the offset is set to 30%, the dimming level of channel 2 is 30% higher than the dimming level of 
channel-1. 
Remark:  
An offset can only be configured if the light regulation is set to automatic or semi automatic and the 
Light regulation CH-2 is enabled.   
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5.1.2.  Modes 
 

 Motion detection 
Three different settings are possible: 

o Automatic 
Light will switch on if somebody enters the detection area and will switch off if no motion is 
detected and the delay time expired.  
Remark:  
If daylight regulation is active and the amount of incoming daylight is sufficient, the light will not 
be switched on by motion signals. 

o Semi automatic 
Light will not switch on if somebody enters the detection area, switch on requires a manual 
action by the user, e.g. pressing the push button. Light will switch off if no motion is detected 
and the delay time has expired. 

o OFF 
Motion detection is disabled 

 
 Light regulation 

Three different settings are possible: 

o Automatic 
Light will be regulated according to incoming daylight and the stored set point. It will be 
switched off, if the amount of daylight is sufficient. If the amount of daylight decreases below 
set point light will switch on automatically. 
Remark: If motion detection is enabled, automatic switch on by decreasing daylight is disabled 
when no persons are within the detection area and the delay timer has expired. 

o Semi automatic 
Light will not switch on if the amount of daylight falls below the regulation set point. Switch on 
requires a manual action by the user e.g. pressing the push button. 
Remark: If motion detection is enabled, light will switch on by decreasing daylight 
automatically when persons are within the detection area or the delay timer has not expired 
yet.  

o OFF 

Light regulation is disabled. 

 Switch off at sufficient daylight 
If this check box is true, the daylight dependent regulation will switched off the channel-1 and 2, if 
the amount of daylight or ambient light is sufficient. If the corresponding check box is false, the 
artificial light will stay at the configured Min Level (see Advanced functions 2 tab) as long as the 
control unit is in ON-state, Stand-by 1 state or Stand-by 2 state. 
Remark: 
- Setting of this parameter is disabled when the light regulation is set to OFF 
- If Light regulation CH-2 is disabled, channel-2 will not switch off due to sufficient daylight. 

 

 Light regulation CH-2 
If this check box is true and daylight regulation is active, CH-2 is linked to CH-1 by the Offset. If the 
check box is false, light regulation of CH-2 disabled and all values for CH- 2 are absolute static 
values (= channel is in a pure control mode, not linked to CH-1). 
Remark: 
- Setting of this parameter is disabled when the light regulation is set to OFF.  
- If light regulation of CH-2 is disabled and therefore CH-2 is not linked to CH-1 by Offset, a  
 manual dimming of CH-2 will not interrupt daylight regulation of CH-1. 

 

 



 

 

 
Page 9 of 19 

 
  

5.2. Advanced functions 

5.2.1. Advanced functions 1 
 

 
 

5.2.1.1. Settings DALI Channel 
 

 Stand-by 2 level 
This level will be established after leaving the Stand-by 1-state. If the light regulation is  
activated, the displayed percentage value is not an absolute dimming level but a relative value of 
the set point. If the Stand-by 2 level for both channels is set to OFF, the controller will skip the 
Stand-by 2 state and will directly change to the OFF-state. 

 
Example for a relative stand-by level: If the stand-by level is set to 50%, the controller will reduce 
the regulation down to 50% of the regulation level choosen for the ON-state. 
 
Remark: 
- If light regulation is enabled, CH-1 and CH-2 are linked by the choosen offset. 
- If light regulation is disabled for CH-2 only, a separate static absolute value can be set for CH-2. 
- If light regulation is set to OFF, the stand-by levels are absolute static values and can be   set for  
 channel 1 and 2 differently. 
- Configuration of a Stand-by 2-state is only possible, if a Stand-by 1-state exists. 

 
 

 Stand-by 2 time 
This is the time after that the controller will leave the Stand-by 2 state and change to OFF- state. 
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5.2.1.2. Settings General 
 

 100h burn in 
If this function is enabled, the controller will block dimming for 100h.  
A burn in is recommended especially for low pressure discharge fluorescent lamps to achieve 
proper dimming quality and the full lamp lifetime. As long as the burn in procedure is active the 
Sensor LED is permanently lit red.  
Important Remark:  
During the burn in process the DALIeco control unit will not react to the Remote or push button 
operations. The process can only be interrupted by either entering the programming mode and 
pressing the burn in button of the master remote or by disabling this function via the PC software 
and transfer this setting to the controller by the master remote. 
 

 Autosetup delay 
The auto setup reveres to the nominal light output of the luminaire. Fluorescent lamps need a 
certain time until the full luminous flux is established; therefore by setting this check box to true, a 3 
minutes delay, where the light output is set to 100%, can be activated before the automatic set 
point storage is performed. 

 

 Automatic compensation of lamp aging 
If this function is enabled and the light regulation is set to OFF the controller will increase the DALI 
levels of all stages periodically by one step until 100%. 
Remark: 
The compensation starts/is reset when new levels for the ON-state are programmed. 
The Automatic compensation of lamp aging is linked with the parameter Constant lumen burning 
hours. 

 

 Constant lumen burning hours 
This are the number of burning hours that will elapse until the Light source will be at end of life and 
the ON-level will reach 100% 

 
Example for Automatic compensation of lamp aging with Constant lumen burning hours: 
The initial light output for an LED fixture to reach the desired lux level on a floor of a manufacturing 
hall is calculated with 70%. Service lifetime of the fixture is 50.000h.  
  Set the Constant lumen burning hours to 50.000 and enable Automatic compensation of  
 lamp aging. 
  Set the ON level to 70% 
 
  The control unit will increase all levels periodically. After 50.000h the ON level will reach 100%  

 

 PIR inhibit time 
This time defines how long motion signals will be ignored and do not lead to a switch on after a 
manual switch off by the user.  
Remark:  
The PIR inhibit timer is retriggered by every motion signal. 

 

 State after power failure 
This setting defines the power up state the controller will establish after a mains interruption. 
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 Smoothing of dimming 
This parameter allows to improve the dimming performance especially of LED solutions by 
programming a DALI Fade time to the connected ballasts. 
Following settings are possible: 
o None = DALI Fade time 0 
o Low = DALI Fade time 1 
o Medium = DALI Fade time 2 
o High = DALI Fade time 3 

 
Remark:  
The transfer of the corresponding DALI Fade Time to the ballasts is done in the power up phase of 
the controller, so a change of this parameter requires/is effective after power interruption of the 
system. 
 

 
 

5.2.1.3. Settings Synchronization 
 

If control units are interconnected, an exchange of information is possible which allows a synchronous 
behaviour of lighting control installations consisting of multiple DALIeco controllers. The 
synchronization can be achieved by a 2 wire cable connection or wirelessly by using the DALIeco 
Swarm Adapter.  
 

 Motion detection 
If this function is enabled, the control unit will share own motion signals with the 
interconnected units and react on motion signals from other units. 

 

 On via push button coupler 
If this function is enabled, the control unit will share the switch on event by a press on the 
push button connected to push button coupler input C and react to corresponding switch on 
events from push button couplers from other units. 

 
 Off via push button coupler 

If this function is enabled, the control unit will share the switch off event by a press on the 
push button connected to push button coupler input D and react to corresponding switch off 
events from push button couplers from other units. 
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5.2.2. Advanced functions 2 
 

 
 

5.2.2.1. Settings DALI Channel 
 

 Max level / Min level 
To avoid too low or too high levels of artificial light, the dimming range can be restricted by setting 
an individual Min level or Max level. 
Remark: 
- These Min and Max setting affect light levels of all states, therefore it is recommended to  first  
 set the required Min and Max level and afterwards configure the light levels of ON- and Stand-by 
 states. 
- If light regulation is enabled, Min and Max levels of CH-1 are valid for CH-2 also. 
 If light regulation is set to OFF or disabled for CH-2, different Min / Max setting for the 2  
 channels are possible. 

 

 Fade between states 
If this checkbox is set to false, the change between states takes place instantly without fading. 
Remark: 
- A change to “ No fade between states” is only possible, when the light regulation is set to OFF . 
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5.2.2.2. Settings direct connected Push button and Push button coupler  
 

 Double Click / Set point storage 
If this check box is true and the light regulation is enabled, setting of a individual regulation set 
point is possible by dimming the light to the required level and double click on a direct connected 
push button.  
If this check box is true and the light regulation is disabled, an individual ON level can be set by 
dimming the light to the required level and double click on a direct connected push button. 
If this check box is set to false, double click to direct connected push buttons will be ignored. 

 
 

 Use sync. as 2nd push button input 
If this check box is true the Sync. input of the control unit is unlocked for manual control and can 
work as 2nd push button input, allowing an individual manual control of CH-2.  
Remark: 
- To activate the push button control for CH-2 a push button has to be connected between push  
 button input and GND, a second push button between Sync. and GND. By pressing  both 
buttons  simultaneously for 10s the two push button control mode is activated and 
 confirmed by blinking of the lamps. 
- To deactivate the push button control for CH-2 both buttons have to be pressed 
 simultaneously for 20s, deactivation is confirmed by blinking of the lamps. 
- If the check box Use sync. as 2nd push button input, the normal Sync. functionality is   
 disabled. 

 
 

 Dimming (Push button coupler)  
If this check box is true, a manual dimming / interruption of light regulation via push buttons 
connected to the push button coupler is possible. 

 

 Dimming (Direct connected push button)  
If this check box is true, a manual dimming / interruption of light regulation via push buttons directly 
connected to the DALIeco control unit is possible. 
 
Remark: 

Manual dimming by directly connected push buttons or via push button couplers interrupt 
the automatic daylight regulation.  
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5.3. Remote control functions 
 
The remote control functions tab allows enabling / and disabling dedicated buttons of the master 
remote. In a special OEM mode only the PC 1 / PC 2 button is enabled.  
 
 

 
 

 Selecting the OEM Mode 
The OEM mode allows a simplified programming of DALIeco during luminaire production process. 
Selecting the OEM mode only the two PC mode buttons of the master remote are enabled.  

 
 
On demand PC1 or PC2 button can be disabled individually. 
Within the OEM mode the configuration can be transmitted by a single button press onto the PC1 
or PC2 button without entering the programming mode.  

 
 

 Locking / unlocking master remote keys 
All keys can be enabled/unlocked or disabled/locked by clicking onto the depicted key of the 
master remote picture. The lock / unlock status changes at every click. 
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A disabled/locked key is highlighted in dark grey. 

Enabled/unlocked 

key

Disabled/locked 

key

 
Remark: 
All keys can be enabled/unlocked by the Reset remote control key locks button 
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6.  Setup and transfer configurations to the Master Remote 

6.1. Setup and transfer a complete new configuration to the Remote 

6.1.1. Step 1: Create a new project (optional) 
 
 
Create a new project by clicking on the icon   of the tool bar or the file menu  

6.1.2. Step 2: Select base operation mode 
Select the base operating mode that corresponds to the target application by clicking on one of the 
keys  

 
 
 
 
 

6.1.3. Step 3: Adjust individual parameters 
Change parameters on the Base functions or the Advanced functions tabs as required (see Chapter 
5). 

6.1.4. Step 4: Transfer the configuration to the master remote 
1. Check if Master remote is connected to the PC via USB  

Remark:  
Please use the original OSRAM red USB cable with integrated USB driver Chip only! 
 

2. Choose the Upload icon from the tool bar or the point Upload DALIeco Configuration from 
the Transfer menu  

 
 
3. Select the storage target and press Next 

 
Remark:  

PC mode 1 storage corresponds with the PC1 button PC mode 2 storage with the PC 2 button of 

the master remote. 
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4. Select the transfer type 

 
 

 If you do not know the version / build date of the DALIeco control unit, chose “All 
function settings” which transfers all parameters independent of the chosen function 
mode  

 For DALIeco control units with IC AB3233802G3 / date code 17xx or newer please 
chose “optimized selection and transmission”, which reduces the amount of data and 
increases reliability and possible distance of the IR transmission 

 
5. Press OK to start the transfer. 

 

6.2. Setup and transfer an individual parameter 
If only a single or a couple of parameters should be transferred to the DALIeco control unit to change 
an existing configuration, following steps have to be performed.  
 

6.2.1. Step 1: Select a suitable base operation mode 
 
Select the base operating mode that offers the setting possibility for the corresponding parameters by 
clicking on one of the keys  

 
 
 
 
 
 
 

6.2.2. Step 2: Adjust individual parameters 
Change the corresponding parameters on the Base functions or the Advanced functions tabs as 
required. 

6.2.3. Step 3: Transfer the individual parameters to the master remote 
 

1. Check if Master remote is connected to the PC via USB  
Remark:  
Please use the original OSRAM red USB cable with integrated USB driver Chip only! 

 
2. Choose the Upload icon from the tool bar or transfer menu  

 
 



 

 

 
Page 18 of 19 

 
  

3. Select the storage target and press Next 

 
Remark:  

PC mode 1 storage corresponds with the PC1 button PC mode 2 storage with the PC 2 button of 

the master remote. 

4. Select the transfer of Single parameters 

 

 

5. Select the parameters that should be transferred 

 
In this example only the Switch off delay time and the Stand-by 1 level will be transmitted. 

 

6. Press “OK” to start the transfer. 
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7. Transfer configurations from the Master Remote to the 
DALI control unit 

The configuration stored in the memory of the Master Remote can be transferred via Infra-
Red to the DALIeco control unit. 
 
Step 1:  
Point with the Master Remote to the DALIeco sensor and make a long press to the “PROG” 
button of the Remote.  
 Lights will flash 1x to indicate that the DALIeco control unit is in programming mode. 
 
Step 2:  
Point with the Master Remote to the DALIeco sensor and make a short press on the “PC 
mode 1” or on the “PC mode 2” button of the Remote.  
 Lights will flash 2x to indicate that the transmission of the configuration was successful 
 
Remark: if lights do not flash two times please reduce distance between Remote and sensor 
point straight to the sensor and retry. 
 
Step 3:  
Terminate the Programming mode of the DALIeco control unit by a short press to the 
“PROG” button of the Remote. 
 Lights will flash 1x and go back to last state before the programming mode 

8. Miscellaneous 
 
For information about the software version and display of release notes please click  
on the About OSRAM DALIeco PC-Software entry in the Help Menu 
 
To open the user manual as PDF document please select the Show help entry. 
 

 
 


